Chapter 21

Practical Application for Late Beginning Internet Users
In the previous chapter you learned a number of methods for starting the internet, doing web searches, working with links, and reading with screenreaders and a screen enlarger. Aside from links and text on a web page, there can be many other types of items. Buttons, check boxes, edit boxes, combo boxes, lists, frames and tables are some of the more common items on a web page. Headers are an aspect of some web page that are similar to links, but act to help speed up navigation on the web site.

Internet Explorer Toolbar
Before looking at actual web pages, we will now explore the Internet Explorer “Tool Bar.” This toolbar has a number of helpful items, including “Back, Forward, Refresh, Home, Search, Favorites, History, Mail, Print, Edit, Discuss, Research,” and others. While there are a number of key combinations which will allow you to easily use items on the “Tool Bar,” you can also list them in several of the screenreader, and then use your up and down arrow keys to move to the item you want to use, and tap the Enter Key one time to activate that item.
JAWS Internet Explorer Tool Bar

If you are using the JAWS screenreader, press and hold down the Insert Key and tap the F8 Key one time. Release both keys and the Internet Explorer Tool Bar will appear.

Screenshot of Internet Explorer Tool Bar using the JAWS screenreader.
www.satogo.com Internet Explorer Tool Bar

If you are connected to the internet and are using the free online screenreader www.satogo.com you can press and hold down the Insert Key, tap the F8 Key, and then release both keys to bring up the list of items for the Windows Internet Explorer Tool Bar. Just as with the JAWS screenreader, you can use your up and down arrow keys to move to an item you want to use, and tap the Enter Key one time to begin using it.

WinEyes and NVDA Method for Accessing the Internet Explorer Menus (also works with the JAWS and NVDA screenreaders)

In the cases of WinEyes and NVDA screenreaders there appears to be no direct key combination to list the items on the Internet Explorer Tool Bar. There is a method for accessing the menus of the Internet Explorer, with has a number of items found in the Tool Bar. Simply tap the Tab Key one time, and you will be able to use your left and right arrow keys to move through the different menus. Once you are on a menu that you are interested it, use your up and down arrow keys to explore the items in that menu.

Screenshot of the “View” menu, and the “Explorer Bars” sub menu, containing items such as “Favorites, History, Research.” The Alt Key was tapped one time, right arrow was used to go to “View,” down arrow was used to go to the “Explorer Bars,” and right arrow was used to open the sub menu containing “Favorites, History, Research.”
Internet Explorer Tool Bar Common Key Commands

There are a number of “Universal Key Commands” for using items found in the Internet Explorer menus and Tool Bar. These “Universal” commands will work on any screenreader or screen enlarger.

**Favorites:** There may be a web page you want to go back to again-and-again. Press and hold down the Alt Key and tap the letter “a” one time. If you are using Firefox, the command is Alt “b.” Release these two keys. You will be at the top of a menu, on the menu item that says “Add to Favorites.” Tap the Enter Key two (2) times to save this web page address into your Favorites (Bookmarks in the case of Firefox). The next time you want to go to this web page, you can use one of the earlier taught methods to go there, or you can press the Alt “a” key combination (Alt “b” in the case of Firefox), down arrow until you hear the name of the web page, and then tap the Enter Key one time to go there.

**Refresh the Computer Screen:** Sometimes a web page will act erratically, or not work correctly. One common method for fixing this situation is to tap the F5 Key one time. This literally means “redraw the screen.” When you do this, the memory where the screenreader stored the information concerning the present web page is cleared, and a fresh set of information is put in its place.

**Find:** There will be times when you find it most expedient or fast to search for a particular word or phrase on a web page. Press and hold down the Control Key and tap the letter “f” one time. Type the word or phrase you want to find or go to, and then tap the Enter Key one time to go there.

**Back:** There will be times when you have moved through a number of web pages and need to move back one or more of these pages. Press and hold down the Alt Key and tap the left arrow key to move back one web page—continue this process to move back through more of the web pages. Tapping the Backspace Key often does the same “Back” movement through web pages.

**Forward:** There will be times when you have moved back a number of web pages and need to move forward to a different web page. Press and hold down the Alt Key and tap the right arrow key one time for each page that you want to move forward to.

**Print:** There will be times when you need to print a hard copy of the web page you are on. It might be a page containing directions, a story, or other item of interest. Press and hold down the Control Key and tap the letter “p” one time. A dialogue box will come up. Tap the Enter Key one time and the web page will be printed on paper.
Save: There will be times when you need to save a web page. To save a web page, press and hold down the Alt Key and tap the letter “f” one time to bring up the “File” menu. Tap the letter “a” one time and the “Save As” dialogue box will come up. Tap the Enter Key one time and a copy of the web page will be saved. If you do not use the “Save In” combo box in this dialogue box, the web pages will be saved to the last folder into which you saved a web page—if this is your first web page save, the file will probably be saved in your “My Documents” folder.
Internet Explorer Tool Bar Activities

Activity 1

1. Press and hold down the Windows/Start Key and tap the letter “a.”
2. Release both of these keys.
4. Tap the Enter Key one time.
5. Press and hold down the Alt Key and tap the letter “a” one time, after the web site has come up. You will be at the top of a list and on an item that says “Add to Favorites.”
6. Tap the Enter Key one time and an “Add a Favorite” dialogue box will come up.
7. Tap the Enter Key one more time and www.brlsts.com will be added to your list of favorite web sites. You will be placed back on the www.brlsts.com web page.

Note: In the “Add a Favorite” dialogue box there are buttons which will allow you to save the web page as a favorite in a different folder—you can experiment and see what is in this dialogue box by tapping the Tab Key to move through it.

Note: If you are using Firefox, press and hold down the Alt Key and tap the letter “b” (for bookmark). Tap the Enter Key two times and your web page will be saved in “Bookmarks.”
Activity 2

1. Open the internet.
2. Press and hold down the Alt Key and tap the letter “a” one time.
3. Release both of these keys.
4. Down arrow through the list of “Favorites” until you hear the web page you want to open. You can also tap the first letter of the name of the “Favorite,” if you know which one you want.
5. Tap the Enter Key one time to open you “Favorite” web page.

Note: If you are using Firefox, press and hold down the Alt Key and tap the letter “b.” A list of bookmarked web pages will come up. Either down arrow or tap the first letter of the name of the web page, and then tap the Enter Key one time to open that bookmarked web page.
Activity 3

1. Open the www.brlsts.com web site.
2. Tap the Tab Key until you hear “Travel Resources.”
3. Tap the Enter Key one time.
4. Press and hold down the Control Key and tap the Home Key to make sure you are at the top of this web page.
5. Tap the Tab Key one time to move to the “Indygo Bus and Flex Route Resource.”
6. Tap the Enter Key one time.
7. Press and hold down the Control Key and tap the Home Key one time to make sure you are at the top of this web page.
8. Tap the Tab Key until you hear “Indygo Fixed Route Schedules.”
9. Tap the Enter Key one time. You are on the web page that has Adobe PDF and Excel files for all of the fixed route buses in Indianapolis, Indiana.
10. Press and hold down the Alt Key and tap the left arrow key one time to move back one web page to the www.brlsts.com web page (you will be on the Indygo Fixed Route Schedules link).
11. Press and hold down the Alt Key and tap the right arrow key one time to move forward to the Indygo web page.
12. Press and hold down the Alt Key and tap the left arrow key to move backward to the www.brlsts.com web page.

Note: You can use the Backspace Key instead of the Alt left arrow key combination to move backward one web page.
**Headings or Headers**

**Working with Headers Using the JAWS Screenreader**

Let's take a common web site called Reuter's. The web address for Reuter's is [www.reuters.com](http://www.reuters.com). On the open page there can be easily over one-hundred links on any given day. We can explore all of these links, but this will take time. A faster approach to seeing what is on the Reuter's web site is to use headers. On the same web page that has over one-hundred links there may be only thirty or so headers. Tap the letter “h” to move down the headers on the Reuter’s web page. You can press and hold down the Shift Key and tap the letter “h” to move back up the headers on the web page. Another way to work with headers on the Reuter’s or any web page with headers when using the JAWS screenreader is to press and hold down the Insert Key and tap the F6 Key one time. Release these keys and wait a moment. A list of all of the headers on the web page will come up. At this point, just as you did with links in the last chapter, you can press the Control Home key combination to move to the top of the list, Control End to move to the bottom of the list, or simply use you up and down arrow keys to explore the headers list. If you know the first letter of a header you want to move to quickly, simply tap that letter until you hear the header, and then tap the Enter Key one time to open (or activate) that header.
Working with Headers using the WinEyes Screenreader

WinEyes will bring up a headings list, but does this a bit differently than the JAWS screenreader. With WinEyes, you press the Insert Tab key combination, just like you did to bring up the WinEyes links list. In fact, the links list is what will appear. When the links list comes up, press and hold down the Alt Key and tap the letter “h” for “Headings.” A list of headings will immediately appear. You can press Control Home to go to the top of this list, Control End to go to the bottom of this list, use your up and down arrow keys to explore the list item-by-item, or tap the first letter of the name of the header you want to open (or activate). Tab the Enter Key one time on the header you want and it will be activated and you will be taken to the area of the web page where this header is located. One nice feature of this WinEyes dialogue box is that you can toggle between links and headers by pressing Alt “h” for header, Alt “l” for link, and do several other tasks which will be covered later.

Screenshot of a header list when using the WinEyes screenreader.
Working with Headers using the NVDA Screenreader

At this time you cannot bring up a links nor a header list using the NVDA screenreader. You can tap the letter “h” to move down the headers on a web page, and press (and hold down) the Shift Key and tap the letter “h” to move up the headers on a web page. NVDA does offer a dialogue box which allows you to select the types of items you want reported in a document or on a web page. This dialogue box falls under the “Document Formatting” area of NVDA. You can activate this box type pressing and holding down the Insert and Control keys, and tap the letter “d” one time, and then release all three keys. The list will appear. At this point you can move down the list, tapping the spacebar to check or uncheck any of the radio buttons—each button indicates a type of item you want NVDA to either not report, or report.

Screenshot of NVDA Dialogue Box for reporting items in a document or on a web page.
Working with Headers using the [www.satogo.com](http://www.satogo.com) Screenreader

The Satogo screenreader works very much like the JAWS screenreader when it comes to working with headers on a web page. You can tap the letter “h” to move down the headers on a web page, or press and hold down the Shift Key and tap the letter “h” to move up the headers on a web page. You can bring up the “Headings” list by pressing and holding down the Insert Key and tapping the F6 Key one time. When this list comes up you can press Control Home to go to the top of the list, Control End to go to the bottom of the list, or use your up and down arrow keys to explore the list item-by-item. You can tap the first letter of the name of a heading to move to that heading, and then tap the Enter Key one time to active it and move to that part of the web page.

Screenshot of a header list when using the [www.satogo.com](http://www.satogo.com) screenreader.
Frames

Frames are areas on a web page that divide one part of the page from another. One example of this is a web page that has a top frame showing the name of the web site and possibly links to other parts of the web site. There might be a “Search” box on this top frame. Below this top frame might be two frames which take up the rest of the web page. In this case, there would be a left frame and a right frame. In the left frame you might find text information, or links to other parts of the web site, or even check boxes or buttons. On the right side frame might be text, or links and text. Each web site varies, but the concept is still the same. When using a screenreader it is easy to become stuck in one of these frames, or become disoriented. Most screenreaders have methods for navigating through the frames on a web page. In many cases as you move from frame-to-frame, you will notice it says “untitled.” Because there are generally only a few frames per web page, this is not a complete disaster. As accessibility laws more clearly define the constructs for web sites, this issue may become rare.
The JAWS Screenreader and Frames

If you are using the JAWS screenreader and want to view the frames on a web page, press and hold down the Insert Key and tap the F9 Key. Release both of these keys and the list of frames for the web page you are on will appear. It is then a matter of using your up and down arrow keys to explore the few frame, and then to tap the Enter Key one time on the frame you want in order to go to that part of the web page.

Screenshot of a frames list using the JAWS screenreader.
The WinEyes Screenreader and Frames

If you are using the WinEyes screenreader and want to view the frames on a web page, press and hold down the Insert Key and tap the Tab Key one time. Release both of these keys and the dialogue box with links will come up. To switch to a view of the frames on the web page, press and hold down the Alt Key and tap the letter “r” one time. The links list view will be changed to a frames list view. Use your up and down arrow keys to explore the frames in the list, and tap the Enter Key one time on the frame you want to go to. You can also press and hold down the Control Key and tap the Tab Key to move forward through the frames on a web page. To move backward through the frames press and hold down the Control and Shift Keys and tap the Tab Key.

Screenshot of a Frames list using the WinEyes screenreader.
The NVDA Screenreader and Frames

If you are using the NVDA screenreader and want to move through the frames on a web page, tap the letter “m” to move forward through them. You can experiment with holding down the Shift Key and tapping the letter “m” to move backward through the frames on the web page.

The www.satogo.com Screenreader and Frames

At this time there does not appear to be a method for moving through the frames on a web page using www.satogo.com.
Lists

Lists are similar to links and headers. They provide another way to efficiently and quickly move through a web page.

JAWS and Lists

If you are using the JAWS screenreader you can tap the letter “l” to move forward through the lists on a web page, or Shift “l” to move backward through the lists on a web page. When you hear the beginning of a list you are interested in, tap the down arrow key to move through this list, or if you want to move back up the list, tap the up arrow key. Another method for working with lists on a web page when you are using the JAWS screenreader is to press and hold down the Insert Key and tap the F3 Key one time. The “Virtual HTML Features” list box will come up. You can use your up and down arrow keys to explore this list—you will hear items such as “Links, Headings,” and so on. You can select from one of two different types of “Lists.” The first is “List Items List,” and it contains the entire list plus all of the items in the list. The second “List” item you will hear is “Lists List.” This is a more general list of the lists on the web page. Tap the Enter Key one time on either one of these and the list items will come up in a new list. Use your up and down arrow keys to explore this list, and tap the Enter Key one time on any item you wish to go to. After you tap Enter, you will be placed on that item on the web page—if this item happens to be a link in nature, you will be taken to a new web page.
Screenshot of the “Virtual HTML Features” list where the “Lists Items List,” and the “Lists List” items are found.
WinEyes and Lists

If you are using the WinEyes screenreader, press and hold down the Insert Key and tap the Tab Key one time. Press and hold down the Alt Key and tap the letter “i” one time—a list of the lists on the web page you are on will appear. Instead of saying the list item name, WinEyes will say “List _____ with _____ items.”

SATOGO www.satogo.com and Lists

There does not appear to be a way to bring up a list of list items on a web page using the www.satogo.com web based screenreader. You can tap the letter “l” to move forward through the lists on a web page, and press and hold down the Shift Key and tap the letter “l” to move backward through the lists on a web page.

NVDA and Lists

There does not appear to be a way to bring up a list of list items on a web page using the NVDA screenreader. You can tap the letter “l” to move forward through the lists on a web page, and press and hold down the Shift Key and tap the letter “l” to move backward through the lists on a web page.
Anchors

An anchor is a hyperlink that sends you from one part of the web page to another part of the same web page. This is different than a link. Links generally send you to another web page.

JAWS and Anchors on a Web Page

There are generally not many anchors on a web page, if any at all. If you are using the JAWS screenreader and want to see if there are anchors on the web page you have open, tap the letter “a” to move forward—if there are any anchors you will be taken to the first one on the web page. Continue to tap the letter “a” to see if there are other anchors on the web page. Press and hold down the Shift Key and tap the letter “a” to move backwards through the anchors on the web page. If you want JAWS to list the anchors on the web page, press and hold down the Insert Key and tap the F3 Key one time. Release both keys and you will be placed at the top of a list of web related items, on the “Anchors” item. Tap the Enter Key one time to move to the list of anchors on the web page. Use your up and down arrow keys to see what anchors are on the page—if you hear an anchor that you want to go to, tap the Enter Key one time and you will be placed there.
Screenshot of “Anchors” list on a web page using the JAWS screenreader.
WinEyes and Web Page Anchors

WinEyes tends to list many anchors, whereas the JAWS screenreader does not. This may be caused by the way each of these two screenreaders interpret what an anchor really is. Try tapping the letter “a” and Shift “a” to move through anchors, when using the WinEyes screenreader—most of the time you will hear items referred to as “links.” If you want to list the anchors on a web page using the WinEyes screenreader, press and hold down the Insert Key and tap the Tab key one time. When the list of links comes up, press and hold down the Alt Key and tap the letter “n” to change the view to a list of the anchors on the web page. You can use your up and down arrow keys to explore these anchor items, and tap the Enter Key one time on one of these items to go to that place on the open web page.

NVDA and Anchors

At this time the NVDA screenreader does not appear to support finding anchors on a web page.

SATAGO www.satogo.com and Anchors

If you are using the www.satogo.com screenreader, tap the letter “a” to move forward through the anchors on a web page, and Shift “a” to move backwards through the anchors on a web page. There does not appear to be a command to bring up a list of the anchors on a web page.
Graphics

A graphic is a pictorial representation of a number of items that might be found on a web page. There are graphical banners, graphical words, pictures, charts, graphs, graphical menus, graphical links and even graphical buttons. A screenreader cannot understand what a graphic says, unless the person who wrote the web page made sure to add a text type tag. There will be some web pages where each graphical item is spoken so that you know what you are on, and other web pages where the screenreader might only say something like “graphic.” There are methods with some screenreaders to label the graphics on a web page. If you do label the graphic on a web page, those labels will only work on the computer where you did the labeling.
JAWS and Web Graphics

The JAWS screenreader has several ways to move through the graphics on a web page. You can tap the letter "g" again-and-again to move down the graphical items on a web page, or you can hold down the Shift Key and tap the letter "g" to move back up the graphical items on the web page. You can bring up a list of the graphical items on the web page by pressing and holding down the Insert Key and tapping the F3 Key one time. Release these two keys and the “Virtual HTML Features” dialogue box will come up. Either down arrow, or tap the letter "g" one time to move to the “Graphics List” list item. Tap Enter on the “Graphics List” item and a list of all of the graphics on the web page will appear. You can use your up and down arrow keys to explore this list, or tap the first letter of the name of the graphic you wish to go to, and then tap the Enter Key one time. After you tap Enter you will be taken directly to the graphic you selected, on the web page.

Screenshot of a graphics list using the JAWS screenreader.
JAWS Graphics Labeler

If you find that you do need to label a graphics to give clarity to an item on a web page, press and hold down the Insert Key and tap the F2 Key one time. The “Run JAWS Manager” dialogue box will appear. You can either down arrow to, or tap the letter “g” one time to move to the “Graphics Labeler” list item. Tap the Enter Key one time on the “Graphics Labeler” item, and then use a type and tab method to label the graphical item. The “Graphics Labeler” works on web pages, graphical items in a computer program, flash based web and program pages, and any other areas where a graphic needs a label.
WinEyes and Web Graphics

To move forward through the graphics on a web page using the WinEyes screenreader, press and hold down the Insert Key and tap the letter “g.” To move backward through the graphics on a web page, press and hold down the Insert and Shift Keys, and tap the letter “g.” If you need to label a graphic you are on, press and hold down the Control and Shift Keys and tap the letter “e.” Release these keys and the Graphic Dictionary will come up. Type a name or description for the graphic and then save the Dictionary.

SATOGO www.satogo.com and Web Graphics

If you are using the www.satogo.com web based screenreader, tap the letter “g” to move forward through the graphical items on the web page. If you need to move backward through the graphical items on the web page, press and hold down the Shift Key and tap the letter “g.”

NVDA and Web Graphics

If you are using the NVDA screenreader and want to move through the graphical items on a web page, tap the letter “g,” again-and-again. Experiment with holding down the Shift Key and tapping the letter “g” to move backward through the graphical items on the web page—this may not work.
Internet Explorer Web Page Navigation Activities

Activity 1

1. Press and hold down the Windows/Start Key and tap the letter “r.”
3. Tap the Enter Key one time.
4. Bring up the links list (or tap the Tab Key if you are using NVDA).
5. Down arrow to the “Shawn’s Resources” list item. Remember you can also tap the letter “s” until you hear “Shawn’s Resources.”
6. Tap the Enter Key one time. You will be on the “Shawn’s Resources” web page.
7. Press and hold down the Alt Key and tap the left arrow key one time. You are now back on the www.brlsts.com web page. Remember, you can also use the Backspace Key to move backward one web page.

Activity 2

1. Open the www.reuters.com web site.
2. Press and hold down the Control Key and tap the Home Key one time to make sure you are at the top of this web page.
3. Move through the headers on this web page by tapping the key that is used for headers in your screenreader.
4. Press and hold down the Shift Key and tap the same header key again-and-again to move up the headers on the web page.

Activity 3

1. Open the www.reuters.com web site.
2. Bring up the header’s list using your screenreader.
3. Up and down arrow through the list of headers. Practice tapping the first letter of the name of a header you are interested in.
4. Tap the Enter Key one time on a header that you want to go to.
5. Use the read key combination for your screenreader (i.e. JAWS and www.satogo.com is Insert down arrow, WinEyes is Control Shift “r”).

Activity 4

1. Bring up the www.reuters.com web site.
2. Either bring up the “list” list, or tap the letter designated for your screenreader to move through the lists on a web page (i.e. JAWS is the letter “I”).
3. When you hear the beginning of a list you are interested in, begin tapping the down arrow to move down that list—you can tap the up arrow key to move back up this same list.
Chapter 21 Review

Test Your Knowledge

1. The ____ is the area on the Internet Explorer where you can access Favorites, Print, Refresh, and other items.
   a. Links list
   b. Internet Explorer Tool Bar
   c. Header

2. ____ is the area of the Internet Explorer Tool Bar or menu where you can save a link to a favorite web site.
   a. Favorites
   b. Address Bar
   c. Frames

3. Tapping the F5 Key on any web page ____s the computer screen.
   a. Closes the web page.
   b. Makes the web page larger.
   c. Refreshes or redraws the screen.

4. Tapping the Alt key one time on any web page places you in the ____s.
   a. Address Bar
   b. Menus
   c. Favorites

5. ____s divide the web page into different areas.
   a. Frames
   b. Links
   c. Headers
6. The content of a web page that is only for reading.
   a. Links
   b. Headers
   c. Text

7. The item on a web page that when clicked or Enter keyed will take you to another web page.
   a. Header
   b. Link
   c. Text

8. Alt left arrow take you:
   a. To the top of the web page.
   b. Forward one web page.
   c. Backward one web page.

9. Backspace and Alt left arrow do the same thing on the internet.
   a. True
   b. False

10. Tapping the Tab Key moves you forward through the links on a web page. Which key combination moves you backwards through the links on a web page?
    a. Alt Tab
    b. Control Tab
    c. Shift Tab

11. Moving to the Internet Explorer Address Bar was covered in the last chapter. Which one key when tapped will place you in the Address Bar.
    a. F5
    b. F6
c. F7

12. Which key combination takes you to the top of a web page?
   a. Control Home
   b. Control End
   c. Shift Tab

13. Which of the following programs is used for working with the internet?
   a. Windows File Explorer
   b. Windows Internet Explorer
   c. System Tray

14. Windows Internet Explorer and Firefox are both:
   a. Word processing programs.
   b. Combo boxes.
   c. Web browsers.

15. Describe your method for quickly reviewing what is on a web page, using information gathered from this chapter.